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About KOffice
KOffice is a free, integrated office suite for KDE, the K Desktop Environment. It consists of the following
applications.
Core applications:
●
●
●
●

KWord - A frame-based word processor that can work in two modes: page oriented or layout oriented
KSpread - A powerful spreadsheet application.
KPresenter - A full-featured presentation program.
Kexi - An integrated environment for creating databases and database applications.

Graphical applications:
● Kivio - A Visio®-style flowcharting application.
● Karbon14 - A vector drawing application.
● Krita - A pixel-based image manipulation program like Adobe© Photoshop® or Corel® Painter™.

Other applications:
● KChart - An integrated graph and chart drawing tool.
● KFormula - A powerful formula editor.
● Kugar - A tool for generating business quality reports.

More information concerning KOffice can be obtained at http://koffice.kde.org/.

Accessibility Overview
Since KOffice applications are built using the KDE libraries and since developers are expected to follow the KDE
Human Interface Guidelines, KOffice applications inherit all the accessibility features and capabilities of KDE. See
http://accessibility.kde.org/reports/ for a Voluntary Product Accessibility Template (VPAT) for KDE, and see
http://accessibility.kde.org/ for KDE accessibility features and capabilities.
This document enumerates the accessibility problems as they exist in the KOffice version 1.4.1 release. It is
assumed that the desktop has KDE version 3.4.1 installed, including kdelibs, kdebase, and kdeaccessibility packages.

The approach is to evaluate each KOffice application from the standpoint of four handicapped persons having the
following disabilities:
1. Mouseless operation. A motor impaired individual who is unable to effectively use a mouse, but able to
operate a keyboard or keyboard replacement device. Each application is evaluated for usability without
a mouse.
2. Low-sighted. An individual who is sight impaired or light alergic, but not blind. In the KDE Control
Center, the HighContrastDark-big theme was set and each application was evaluated for usability in this
desktop theme. The screen resolution was 1024x768.
3. Blind. A blind but hearing individual augmented with a braille or other suitable text reading device.
4. Deaf. An individual with no or very limited hearing, but normally sighted.
Each KOffice application was evaluated under each of these disabilities. Any problems found are enumerated and
possible workarounds suggested. An identifier is assigned to each problem, for purposes of coordination with the
development team. The Fixed? column indicates if the problem has been fixed or will be fixed in version 1.5 of
KOffice, which is scheduled for release in early 2006 (see the KOffice 1.5 section for additional information).
Since the approach is to identify the accessibility problems, this is a negative document. This should be kept in mind
while reading.

Mouseless Operation
General

Id

Problem

Workaround

mo.gen.toolbars

It is not possible to reach or manipulate This is a general KDE problem. It is
the toolbars at the top, sides, or bottom possible to hide the toolbars from the
of screens.
Settings menu. Most functions on the
toolbars can be invoked from the main
menu or using keyboard shortcuts. Use
mouse emulation (Alt+F12) to move
mouse pointer to a toolbar and press
space to “click”, OR use the Mouse
Navigation feature.1, OR assign shortcuts
to toolbar functions using the Settings |
Configure Shortcuts menu item.

mo.gen.iconview

When KDE is configured with the
default color scheme “Plastik”, in
screens containing certain selection
panels (IconView), it is difficult to tell
when focus is on the panel because the
currently selected item's background is
too dark and obscures the focus
rectangle. Examples include: KWord
Open Document dialog, KWord Insert
Link dialog, Quick Access panel in
File Open/Save dialogs.

mo.gen.panel.resize

It is not possible to move dividers
Use the Mouse Navigation1 feature of
between panels in order to resize the
KDE to simulate dragging the divider.
panels. Examples: the divider between
Document Structure panel and main
panel in KWord, the dividers in

Fixed?

This is a general KDE problem. In KDE
Control Center | Appearance and Themes
| Theme Manager, choose a different
theme, OR in KDE Control Center |
Appearance and Themes | Colors, choose
a different color scheme, or in the Widget
Color frame, choose Selected
Background and lighten the color. This
permits the focus rectangle to be
distinquished from the selection
background color.
Yes

1 Mouse Navigation permits you to simulate mouse pointer movement, clicking, and dragging using the numeric
keypad on the keyboard. The feature is enabled in the KDE Control Center under Peripherals | Mouse. For more
information, see the Mouse section under Settings in the KDE Help Center.

Id

Problem

Workaround

Fixed?

Workaround

Fixed?

KPresenter main screen.
KWord

Id

Problem

mo.kword.tab

Once focus is in the main document
panel, it is not possible to tab out of it.
In turn, this means that many of the
widgets on the screen cannot be
reached without a mouse.

Press Alt+F to pull down File menu.
Yes
Press Esc to close the menu and press
Tab. Focus is now on the Document
Structure panel. Use Shift+Tab to reach
other widgets on the screen that can
receive focus, OR use mouse emulation
(Alt+F12) to move mouse pointer to
another widget and press space to “click”,
OR use the Mouse Navigation1 feature.

mo.kword.shortcuts

When focus is in the main screen,
Use View menu to change zoom level.
global KDE shortcuts do not work.
To display the context menu, use Mouse
For example, Zoom In (Ctrl++), Zoom Navigation1 to simulate right-clicking.
Out (Ctrl--), Popup Context Menu
(Menu).

Partly

mo.kword.docstruct. In the main screen, it is not possible to See mo.kword.tab. Once focus is on the Yes
reach
reach the Document Structure panel.
Document Structure panel, all elements of
the structure can be reached with arrow
keys.
mo.kword.docstruct. It is difficult to invoke functions in the Use Mouse Navigation1 to simulate right- Yes
context
Document Structure panel because
clicking.
they require right mouse click.
mo.kword.formula.c There is a conflict between the KWord This appears to be a bug. An alternate
trli
Italic shortcut and KFormula Insert
shortcut can be assigned using the
Symbol shortcut. Both use Ctrl+I.
Settings | Configure Shortcuts menu item.
mo.kword.formula.s While there is a main menu item for
ymbol
inserting a formula symbol, there is no
menu item or shortcut for selecting
which symbol to insert.

Use standalone KFormula application to Yes
create the formula, OR use Mouse
Navigation1 to select a symbol in the
formula toolbar. A more permanent fix is
to use Mouse Navigation1 to drag the
formula toolbar to the top of the screen.
The Symbol box can then be reached via
Tabbing (see mo.kword.tab). Also, some
of the symbols can be inserted by first
typing a letter, selecting the letter and
pressing Ctrl+G (Convert to Greek).

mo.kword.formula.d There is no menu item or shortcut for
elim
inserting formula delimiters.

Use standalone KFormula application to
create the formula, OR use Mouse
Navigation1 to insert a delimiter from the
formula toolbar OR shortcuts can be
assigned using the Settings | Configure
Shortcuts menu item.

mo.kword.formula.f There are no menu items or shortcuts
unc
for inserting Roots, Fractions,
Brackets, Abs(), Overline, Underline,
Integral, Sum, or Product into a
formula.

Use standalone KFormula application to
create the formula, OR use Mouse
Navigation1 to insert from the formula
toolbar, OR shortcuts can be assigned
using the Settings | Configure Shortcuts
menu item.

Id

Problem

Workaround
1

Fixed?

mo.kword.textframe. Difficult to create a text frame.
create
Requires sizing of frame using mouse.

Use Mouse Navigation to simulate
dragging frame border. A single click is
all that is needed; the size can then be
adjusted using Frameset Properties
dialog.

Yes

mo.kword.frame.cur No mechanism to move cursor outside
sor
of a floating (text) frame. No
mechanism to move cursor into an
existing floating frame. Tab key
doesn't work.

Use text Find function to find text
outside/inside the frame, OR use Mouse
Navigation1.

Yes

mo.kword.frame.sel No menu item or shortcut to select a
ect
frame. Difficult to delete, move, or
resize a frame or change frame
properties.

Use Mouse Navigation1 to select frame
Yes
border or hold down Ctrl key and click
inside frame. If cursor is outside a frame,
hold down Shift key and use arrow keys
to select the frame. You may then delete
the frame or change some frame
properties.

mo.kword.table.crea It is difficult to create a table because
te
mouse must be clicked to position the
table.

Use Mouse Navigation1.

Yes

mo.kword.table.curs No mechanism to move cursor into or
or
out of a table frame.

See mo.kword.frame.cursor.

Yes

mo.kword.table.row. No mechanism to resize a table row.
resize

Use Mouse Navigation1.

mo.kword.picture.cr It is difficult to insert a picture because Use Mouse Navigation1.
eate
it must be positioned with the mouse.

Yes

mo.kword.picture.se No mechanism to select a picture.
lect
Difficult to delete, move, or resize.

Use Mouse Navigation1.

Yes

mo.kword.splitview. No mechanism to switch between
select
views in split view mode.

Use Mouse Navigation1.

Partly2

KSpread

Id
mo.kspread.tab

Problem
Once focus is in the main spreadsheet
panel, it is not possible to tab out of it.
In turn, this means that many of the
widgets on the screen cannot be
reached without a mouse.

mo.kspread.rowcol.s Not possible to select entire rows or
elect
columns, since the only way to do that
is by clicking on row/column headers,
which cannot receive focus.

Workaround

Fixed?

Press Alt+F to pull down File menu.
Yes
Press Esc to close the menu and press
Tab. Focus is now on the Cell
combobox. Use Shift+Tab to reach other
widgets on the screen that can receive
focus, OR use mouse emulation
(Alt+F12) to move mouse pointer to
another widget and press space to
“click”, OR use the Mouse Navigation1
feature.
Use Mouse Navigation1.

2 The Alt-F8 shortcut can be used to position to any widget that can receive focus, but a better solution (such as
Alt+number) is needed.

KPresenter

Id

Problem

Workaround

Fixed?

Press Alt+F to pull down File menu.
Partly2
Press Esc to close the menu and press
Tab twice. Focus is now on the
Outline/Preview panel. Use Shift+Tab to
reach other widgets on the screen that can
receive focus, OR use mouse emulation
(Alt+F12) to move mouse pointer to
another widget and press space to “click”,
OR use the Mouse Navigation1 feature.

mo.kpr.tab

Once focus is in the slide panel, it is
not possible to tab out of it. In turn,
this means that many of the widgets on
the screen cannot be reached without a
mouse.

mo.kpr.focus

It is difficult to tell which panel of the
main screen has focus, especially when
a panel is empty.

mo.kpr.shortcuts

When focus is in the Outline/Preview Use View menu to change zoom level.
panel, or the slide panel, global KDE To display the context menu, use Mouse
shortcuts do not work. For example,
Navigation1 to simulate right-clicking.
Popup Context Menu (Menu). Zoom
In (Ctrl++) and Zoom Out (Ctrl+-) are
overridden by Increase /Decrease
Depth.

mo.kpr.outline.reach In the main screen, it is not possible to See mo.kpr.tab. Once focus is on the
Partly2
reach the Outline/Preview or Note
Outline/Preview panel, all elements of the
panels.
structure can be reached with arrow keys.
Use Shift+Tab to reach Note panel.
mo.kpr.outline.conte It is difficult to invoke functions in the Use Mouse Navigation1 to simulate rightxt
Outline/Preview panel because they
clicking.
require right mouse click.
mo.kpr.textframe.cre Difficult to create a text frame.
ate
Requires sizing and positioning of
frame using mouse.

Use Mouse Navigation1 to simulate
dragging frame border. A single click is
all that is needed; the size can then be
adjusted using the General tab of the
Format | Properties dialog.

mo.kpr.frame.cursor No mechanism to move cursor from
one frame to another in a slide. Tab
key doesn't work. The Find
workaround of KWord doesn't work
either.

Use Mouse Navigation1.

mo.kpr.frame.select

No menu item or shortcut to select a
frame. Difficult to delete, move, or
resize a frame or change frame
properties.

Put focus in the Outline panel (see
mo.kpr.tab), use arrow keys to select
frame, then press Tab. Arrow keys may
now be used to position frame. Del key
will delete the frame. Use the General
tab of the Format | Properties dialog to
change frame size. Note: These
workarounds do not work with Table
objects.

mo.kpr.table.create

It is difficult to create a table because
mouse must be clicked to position and
size the table.

Use Mouse Navigation1.

mo.kpr.table.cursor

No mechanism to move cursor into or

Use Mouse Navigation1.

Id

Problem

Workaround

Fixed?

out of a table frame.
Use Mouse Navigation1.

mo.kpr.table.move

No mechanism to move a table.

mo.kpr.inaccessible

Preparer stopped evaluating
Use Mouse Navigation1.
KPresenter at this point. There were
too many problems. KPresenter is not
usable without a mouse.

Kexi

Id

Problem

Workaround

mo.kexi.handbook

There is no Handbook for Kexi.

mo.kexi.menu

When navigating the main menu using Use Left Arrow.
Right Arrow key, navigation stops at
the Data menu. This appears to be a
bug, since the menu stays on screen,
but focus goes to the Table Edit panel.

mo.kexi.table.dataty It is not possible to select the data type Use F4 OR use Mouse Navigation1.
pe
of a field in the table editor.
Alt+DownArrow does not work.
mo.kexi.table.pk

When editing the fields of a table, it is
not obvious how to flag a field as a
primary key.

Use Popup Context Menu (Menu key)
and select Primary Key, OR use Edit |
Primary Key on the main menu, OR use
Property Editor.

mo.kexi.pe.boolean

In the Property Editor, is not obvious
how to change a boolean property.
Alt+DownArrow does not work.

Press Space bar.

mo.kexi.pe.value.pic It is not possible to change the value of Use F4 OR use Mouse Navigation1.
klist
a property in the property editor that
has a picklist of possible values, for
example, SubType. Alt+DownArrow
does not work.
mo.kexi.query.create When creating a query, it is not
possible to add a table to the query.

Use Mouse Navigation1 to select and add
table in query toolbar.

mo.kexi.query.colu
mns

Use F4 OR use Mouse Navigation1.

Not possible to select a column, table,
or totals in Query Columns panel.
Alt+DownArrow does not work.

mo.kexi.form.widget It is not possible to add a widget to a
.create
form.

Use Mouse Navigation1.

mo.kexi.form.crash

Bug.

Pressing Tab key while focus is in the
Form Editor window, but not on any
widgets on the form, crashes Kexi.

Fixed?

Yes

Yes

Yes

mo.kexi.form.widget It is not possible to change the size of a Use Property Editor, OR use Mouse
.resize
widget in the form editor without the
Navigation1.
mouse.
mo.kexi.form.tabord It is not possible to change the tab
Use Mouse Navigation1.
er
order of widgets in the Edit Tab Order
dialog. This is a bug. The Up/Down
buttons should be replaced with
PushButtons, not Toolbar buttons.

Yes

Kivio
Note: Because of the graphical drag and drop nature of Kivio, it is not suitable for use in creating files without a
mouse. Kivio was evaluated as a viewer only.

Id

Problem

Workaround

mo.kivio.scrolling

Not possible to scroll main document
window.

mo.kivio.pan

The pan tool only works with a mouse. Use Mouse Navigation1.

mo.kivio.page

Not possible to change pages in a
multi-page document.

Fixed?

Use Zoom OR use Mouse Navigation .
1

Use Mouse Navigation1.

Karbon14
Note: Because of the graphical drag and drop nature of Karbon14, it is not suitable for use in creating files without a
mouse. Karbon14 was evaluated as a viewer only.

Id
mo.k14.scrolling

Problem
Not possible to scroll document
window.

Workaround

Fixed?
1

Use Zoom OR use Mouse Navigation .

Krita
Note: Because of the graphical nature of Krita, it is not suitable for use in creating files without a mouse. Krita was
evaluated as a viewer only.

Id
mo.krita.scrolling

Problem
Not possible to scroll document
window.

Workaround

Fixed?
1

Use Zoom OR use Mouse Navigation .

KChart

Id

Problem

Workaround

Fixed?

mo.kchart.charttype Not possible to choose type of chart or Use Mouse Navigation1.
invoke the chart wizard.
KFormula (standalone application)

Id

Problem

Workaround

mo.kfo.focus

It is difficult to tell when focus is on
the main formula panel, especially
when a formula matrix is not present.

mo.kfo.symbols

No menu item or shortcut for selecting Tab to the symbol button on the toolbar.
the symbol to be inserted by Insert
Press Alt+DownArrow to drop down list.
Symbol function.

Fixed?

Kugar (viewer)

Id
mo.kugar.scrolling

Problem
Not possible to scroll document
window.

Workaround

Fixed?

Use Mouse Navigation .
1

Kugar (designer)

Id

Problem

Workaround

mo.kugar.handbook When selecting Kugar Report Designer Bug. Choose Office | Kugar Designer in

Fixed?

Id

mo.kugar.pe.value

Problem

Workaround

Handbook (F1), displays “There is no
documentation available for
/kudesigner/index.html.”

the KDE Help Center.

It is not possible to choose values in
the Property Editor.

Use Mouse Navigation1.

Fixed?

mo.kugar.item.creat It is not possible to add items (labels, Use Mouse Navigation1.
e
fields, or lines) to a report because
they must be positioned and sized with
the mouse.

Low-sighted Operation
The KOffice applications were evaluated under the HighContrastDark-big theme at a screen resolution of 1024x768.
It is possible to solve many of the dialog sizing problems by increasing screen resolution and using a larger monitor.
General

Id

Problem

ls.gen.opendoc

The Open Document dialog is wider
than the screen. The text of the
Selected Template frame is cut off.

ls.gen.divider

The dividers on screens are a thin
dashed line, making them difficult to
see.

ls.gen.configtoolbars The Configure Toolbars dialog is too
high for the screen.

Workaround
Hold down the Alt key and drag the
dialog with the mouse.

Hold down the Alt key and drag the
dialog with the mouse.

ls.gen.statusbar

The status bar on the main screen is
partially cut off. Bug?

ls.gen.settings

The Settings dialog is too large for the Hold down the Alt key and drag the
screen.
dialog with the mouse.

ls.gen.printpreview.s The Print Preview dialog is too large
ize
for the screen.

Hold down the Alt key and drag the
dialog with the mouse.

ls.gen.printpreview.c The background color of the document
olor
on the Print Preview dialog is white,
not black, i.e., does not honor the
HighContrast Theme.
ls.gen.help

The KDE Help Center displays
Handbook pages with a white
background, i.e., does not honor the
HighContrast Theme.

ls.gen.help.cfgfont.si The Configure Fonts dialog in the
ze
KDE Help Center is too high for the
screen.

Hold down the Alt key and drag the
dialog with the mouse.

ls.gen.help.cfgfont.fr The headers of frames on the
ames
Configure Fonts dialog are cut off.
(“Sizes”, “Fonts”, “Encoding”)
ls.gen.docinfo

The Document Info screen is too large. Hold down the Alt key and drag the
dialog with the mouse.

Fixed?
Yes

KWord

Id

Problem

Workaround

ls.kword.rulers

The rulers are not visible in the main
screen. Tab stops on the rulers are too
small.

ls.kword.connectfra
me

The Connect Frame dialog is too large Hold down the Alt key and drag the
for the screen. The titles of several
dialog with the mouse.
frames in this dialog are partially cut
off.

ls.kword.frame.bord By default, frame borders are black,
ers
which makes them invisible in this
KDE theme.

Change the frame style to a medium dark
background color, such as Dark Gray.
Don't use Black or Dark Blue.

ls.kword.frame.bord Unable to set border color. Changes
ers.color
made in Border Color or Border Syle
Manager are ignored. Bug?

Change background color of frame
instead. Change to a medium color such
as Dark Gray or Light Blue. Do not use
Black or Dark Blue.

ls.kword.frame.style The Frame Style Manager dialog is too Resize the dialog.
mgr
small, cutting off Preview and Color
widgets.
ls.kword.frame.sizeh The frame sizing handles (small
Change background color of frame to a
andles
squares) are dark blue. On this theme's medium color such as Dark Gray or Light
black background they are difficult to Blue. Do not use Black or Dark Blue.
see and too small.
ls.kword.font.dropd
own

The font size in the drop down list of
the font button is too small; does not
honor the theme setting.

ls.kword.table.create The default template for tables uses
Choose a different template when
black borders for the table. When
creating tables.
creating a table, it is not possible to see
it on the black background of this
theme.
ls.kword.table.templ Most the templates for tables are
ates
unsuitable for this theme as they use
white backgrounds. White text on a
white background is not visible. The
most usable themes are Header 3 and
Header 4 but these are only usable in
the header row of table.
ls.kword.table.style
mgr

Change the background color or text
color of the templates or create a new
template.

The Adjust frame in the Table Style
Manager dialog is cut off.

ls.kword.par.settings The Paragraph Settings dialog is too
large for the screen.

Hold down the Alt key and drag the
dialog with the mouse.

ls.kword.par.borders The preview borders are not visible in
the Borders tab of the Paragraph
Settings dialog because they are black
on a black background.
ls.kword.footnote

The Configure Endnode/Footnote
dialog is too large for the screen.

ls.toolbars.border.ic The Border Color and Text

Hold down the Alt key and drag the
dialog with the mouse.

Fixed?

Id
ons

Problem

Workaround

Fixed?

Workaround

Fixed?

Background Color icons on the Border
Toolbar are too small (in this theme).

KSpread

Id

Problem

ls.kspread.sheet.nav The Sheet navigation buttons (lower
left-hand corner of main screen) are
too small.

Use Ctrl+PgDn or Ctrl+PgUp to change
sheets, OR show the Navigation toolbar
(Settings | Toolbars on the main menu)
and use these buttons with Mouse
Navigation.

ls.kspread.font.drop The font size in the drop down list of
down
the font button is too small; does not
honor the theme setting.
ls.kspread.func

The Function dialog is too high for the Hold down the Alt key and drag the
screen.
dialog with the mouse.

ls.kspread.series

The Series dialog is too wide for the
screen.

Hold down the Alt key and drag the
dialog with the mouse.

ls.kspread.char

The Select Character dialog (special
character dialog) is too wide for the
screen. The characters in the matrix
are too small.

Hold down the Alt key and drag the
dialog with the mouse.

ls.kspread.cellformat The Cell Format dialog is too high for
.size
the screen.

Hold down the Alt key and drag the
dialog with the mouse.

ls.kspread.cellformat The Preview frame on the Cell Format
.preview
dialog is cut off.
ls.kspread.cellformat The pattern lines in the Borders tab of
.border.pattern
the Cell Format dialog are black on a
black background and therefore not
visible.

Change the line color to Gray.

ls.kspread.pagelayou The Page Layout dialog is too large for Hold down the Alt key and drag the
t
the screen.
dialog with the mouse.
ls.kspread.text2cols

The Text to Columns dialog is too
wide for the screen.

Hold down the Alt key and drag the
dialog with the mouse.

ls.kspread.calc.size

The Calculator dialog is too large for
the screen.

Hold down the Alt key and drag the
dialog with the mouse.

ls.kspread.calc.color The result box in the Calculator has a
light green background; not honoring
theme.
ls.kspread.toolbars.b The Border Color, Text Color, and
order
Background Color icons on the
Color/Border toolbar are too small (in
this theme).
KPresenter

Id

Problem

ls.kpr.slides.backgro The background color of the slides
und
panel on the main screen is white, i.e.,

Workaround
Change the slide background color from
the Format | Slide Background option on

Fixed?

Id

Problem
the theme setting is not honored.

ls.kpr.fontselect.size The Font Select dialog is too high for
the screen.
ls.kpr.fontselect.sha
dow

Workaround

Fixed?

the main menu. However, you will also
need to adjust default colors for text
backgrounds, borders, font colors, lines,
etc.
Hold down the Alt key and drag the
dialog with the mouse.

The heading on the Shadow frame
(“Shadow”) on the Shadow tab of the
Font Select dialog is cut off.

ls.kpr.cfgslideshow.s The bottom of the selected slides
lides
widget on the Slides tab of the
Configure Slide Show dialog is cut off.
ls.kpr.frame.sizehan The frame sizing handles (small
dles
squares) are too small.
ls.kpr.slides.scrollba The horizontal and vertical scrollbars
rs
of the Slide panel are partially cut off.
ls.kpr.slides.paging

The next/previous slide buttons in the
Slides panel are partially cut off and
too small.

ls.kpr.format.toolbar The Fill Color and Outline Color icons
.icons
on the Format toolbar are too small (in
this theme).
ls.kpr.helplines

Help Lines are not visible.

ls.kpr.textframe.bor
der

The border of text frames is a narrow
dashed line, making it difficult to see.

Kexi

Id
ls.kexi.chooseprj

Problem
The Choose Project dialog is larger
than the screen.

ls.kexi.storagemetho The phrase “Do Not Ask Me Again” at
d
the bottom of the Select Storage
Method dialog is cut off.
ls.kexi.pe.font

The text of the Property Editor is way
too small making it difficult to read.

ls.kexi.dataview.tool The “Row” and “of” labels on the Data
bar.labels
View and Query View toolbars are too
small.
ls.kexi.textview.sql

The background color of the SQL
Query Text box in the Text View has a
dark blue background with black text
when it does not have focus, making it
almost invisible.

ls.kexi.form.widgeth The sizing handles of widgets on the
andles
Form View are black on a black
background, making them almost
impossible to see.

Workaround
Hold down the Alt key and drag the
dialog with the mouse.

Fixed?

Id

Problem

Workaround

Fixed?

Workaround

Fixed?

Workaround

Fixed?

ls.kexi.mainmenu.he The Help menu item on the main menu
lp
is obscured by the view buttons.
Kivio

Id

Problem

ls.kivio.toolbar.form The Text Color, Line Color, and Fill
at.icons
Color icons on the Format toolbar are
too small (in this theme).
ls.kivio.doc.backgro The background color of the main
und
document panel on the main screen is
white, i.e., the theme setting is not
honored.
ls.kivio.toolbar.form The dropdown lists of the Line Width
at.dropdown
and Line Style buttons on the Format
toolbar are black on a dark blue
background, making them difficult to
see.
ls.kivio.toolbar.page The buttons on the page navigation
toolbar (lower lefthand corner of
document panel) are too small.
ls.kivio.sizehandles

The sizing handles and connection
points of widgets on the diagram are
too small.

Karbon14

Id

Problem

ls.k14.doc.backgrou The background color of the main
nd
document panel on the main screen is
white, i.e., the theme setting is not
honored.
ls.k14.rulers

The rulers are not visible.

ls.k14.overview.font The text of the Overview panel is too
small, making it difficult to read.
ls.k14.toolbar.tools.i The icons on the Tools toolbar are too
cons
small.
ls.k14.toolbar.tools.f The buttons on the Fill frame of the
ill
Tools toolbar are way too small.
ls.k14.sizehandles

The sizing handles of objects in the
document are too small.

ls.k14.toolbar.view.i The Context Help icon on the View
con
toolbar is too small.
ls.k14.colormgr

The text of the Color Manager panel is
too small.

ls.k14.pagelayout

The Page Layout dialog is too large for
the screen.

ls.k14.polygon

The Round Corners widget on the
Polygonize dialog is cut off.

Krita

Id
ls.krita.newimage

Problem
The New Image dialog is too large for
the screen.

Workaround

Fixed?

Hold down the Alt key and drag the
dialog with the mouse.

ls.krita.palettes.defa The default palettes (General, Color
ult
Manager, and Tools) do not fit on the
screen. The General palette is cut off.
ls.krita.toolbar.paintt The Painting Tools toolbar is cut of at
ools
the bottom of the screen.
ls.krita.rulers

Right-click on the top of the toolbar and
change the icon size.

The rulers are barely visible.

ls.krita.palette.color The Gray color widget in the Color
mgr.gray
Manager palette is too small.
ls.krita.selection

The selected part of the image is not
visible in the main document panel.

ls.krita.histogram.lo The program locks up when choosing
ckup
Layers | Histogram on the main menu.
ls.krita.imagerestore The Image Restoration dialog is too
large for the screen.

Yes
Hold down the Alt key and drag the
dialog with the mouse.

Yes

KChart

Id

Problem

Workaround

Fixed?

ls.kchart.editdata.bo The borders of the cells in the Edit
rders
Data screen are not visible.
ls.kchart.editdata.tex The text of the cells in the Edit Data
t
dialog are cut off; don't fit inside the
cells.
ls.kchart.selectchartt The selected chart type is not visible
ype
on the Select Chart Type dialog.

Yes

KFormula (standalone application)

Id

Problem

Workaround

ls.kfo.toolbar.add

The buttons on the Add toolbar are cut
off at the right side of the screen.

ls.kfo.doc.colors

The text of the main formula panel is
blue on a black background, making it
difficult to see.

ls.kfo.doc.font.size

The default size of text in matrix cells
is too small.

Increase the Default base size in Settings |
Configure KFormula.

Problem

Workaround

Fixed?

Kugar (viewer)

Id

ls.kugar.doc.backgro The background color of the main
und
document panel is white, i.e., the
theme is not honored.

Fixed?

Kugar (designer)

Id
ls.kugar.opendoc

Problem
The Open Document dialog is wider
than the screen. The text of the
Selected Template frame is cut off.

Workaround

Fixed?

Hold down the Alt key and drag the
dialog with the mouse.

ls.kugar.pe.font.size The text of the rows in the Property
Editor are cut off.
ls.kugar.sizehandles The sizehandles on the main document
panel are too small.

Blind
KDE does not have a general screen reader for blind users. Using the experimental AT-SPI bridge
(http://trolls.troll.no/~harald/accessibility/index.html), it is possible to use the GNOME Gnopernicus screen reader,
but this is difficult to install and configure and requires building from source code for many distributions. Because a
screen reader is not available, KDE in general, and KOffice applications in particular, are not usable by the blind.
This will addressed in a future version of KDE.

Deaf
There are no adverse findings for deaf users. There are no instances in KOffice applications where sound is used to
alert users or is required in order to use the software. If any of the KOffice applications beep, the On Screen Bell
feature, available in the KDE Control Center can be used.

Summary and Conclusions
The following table summarizes the accessibility findings for KOffice 1.4.1. These are the preparer's subjective
conclusions.

Disability /
Application
Evaluation Method

Motor Impaired /
Mouseless Operation

Low-sighted /

Accessibility

KWord

Usable for simple word processing. Not usable for advanced word
processing (frames, tables, pictures, formulas, etc.) unless used in
conjunction with Mouse Navigation1.

KSpread

Usable.

KPresenter

Not usable.

Kexi

Usable in conjunction with Mouse Navigation1.

Kivio

Not usable. In conjunction with Mouse Navigation1, usable as a viewer
only.

Karbon14

Not usable. In conjunction with Mouse Navigation1, usable as a viewer
only.

Krita

Not usable. In conjunction with Mouse Navigation1, usable as a viewer
only.

KChart

Usable in conjunction with Mouse Navigation1.

KFormula

Mostly usable.

Kugar

Usable in conjunction with Mouse Navigation1.

KWord

Mostly usable if appropriate defaults are first configured.

Disability /
Application
Evaluation Method

Accessibility

KSpread

Usable.

KPresenter

Usable.

Kexi

Usable.

Kivio

Mostly usable.

Karbon14

Usable for simple graphics.

Krita

Usable for simple graphics.

KChart

Usable.

KFormula

Usable.

Kugar

Usable.

Blind

All

Not usable.

Deaf

All

100% usable.

HighContrastDark-Big
Theme

Recommendations to Users and System Deployers
1. Be sure to install the kdeaccessibility package.
2. Evaluate different themes and setting for low-sighted users. For example, when using the HighContrastDark-big
theme, changing the color of the Window Background from black to gray will help with visibility problems
associated with frame borders in KWord and KPresenter. If none of your users are light alergic, consider using
the HighContrastLight theme instead.
3. Acquire larger monitors for low-sighted users and increase their screen resolution.
4. Train users in Mouse Navigation feature.
5. Evaluate alternate pointing devices for mobility impaired users, such as trackballs, and eye/head-pointing
devices.
6. Train and encourage users to explore keyboard shortcut capabilities, both in the KDE Control Center and in each
application. For example, “Did you know that there are shortcuts available in the Settings | Configure Shortcuts
dialog that are not associated with any on-screen menu items or widgets?”
7. Prepare a “Shortcut Cheat Sheet” that tells users about “hidden” shortcuts. For example:
● Alt-DownArrow will drop down the picklist of most comboboxes. F4 in Kexi drops down picklists.
● Alt-F3 can be used to move and resize any window, including undocked palette widgets.

8. Create KWord templates with more visible default frame background and border colors and deploy them to lowsighted users.

9. Report KDE accessibility issues and suggestions to the developers. KDE is a Free and Open Source (FOSS)
project that encourages participation by all users, even when not software developers. You can make a
difference. http://www.kde.org/support/

KOffice 1.5
At the time this assessment was prepared, KOffice developers had already fixed or were planning to fix many of the

problems enumerated in this document. The following accessibility enhancements will be part of the KOffice
version 1.5 release scheduled for early 2006.
1. In all applications, except for Kexi, users may size widgets derived from QSplitter or QDockWidget by
pressing F8 or Shift+F8. A resize icon appears on the border between the widget panels. User may
press the arrows keys to simulate dragging of the border. Pressing F8 again rotates through all the
QSplitter or QDockWidget panels on the screen. Shift-F8 rotates in backwards order. Pressing the
keypad Enter key docks or undocks a QDockWidget panel. Esc exits resizing mode.
2. In all applications, except Kexi, users may place focus on any widget that accepts focus by pressing AltF8. Each widget that can receive focus gets a small single-letter or digit label similar in appearance to a
tooltip. When user presses one of these letters or digits, focus is placed on the corresponding widget.
3. In KWord, Go To Document Structure (Alt+1) and Go To Document (Alt+2) shortcuts were added to
permit easy switching between the Document Structure Area and the document.
4. In KWord, a Select Frame action (with shortcut) was added to the Edit menu to permit users to select the
border of current frame without using the mouse.
5. When creating new frames in KWord, user may press Enter to insert the frame at the text caret position,
rather than positioning the new frame with the mouse. The Frame Properties dialog may be used to
resize or reposition the frame.
6. All KOffice applications, except Kexi, have a feature to speak widgets using text-to-speech. With this
feature enabled, when user positions the mouse cursor over a widget, the widget's label is spoken.
Options include speaking the widget's tooltip text, What's This text, and accelerator. This feature is
intended as an aid to low-sighted users; not blind users. Unfortunately, this feature does not work with
all widgets, but with most. This feature will be replaced with a more robust capability when KOffice is
migrated to KDE 4.
7. In KWord, the text of the document may be spoken using text-to-speech in the Document Structure
Area panel. This feature is intended as an aid to low-sighted users; not blind users. This feature will be
replaced with a more robust capability when KOffice is migrated to KDE 4.
8. The startup wizard in all KOffice applications, except Kexi, has been replaced with a new wizard that
fits on the screen better when themes with larger fonts are used.
9. Tabs in dockable panels can now receive focus, which means users can change tabs using the keyboard.
10. In KWord, the global Popup Context Menu shortcut (Menu key) now works in the main document panel
and in the Document Structure Area.
11. In KWord, the Document Structure Area was improved so that users can place the text caret inside any
text frame of the document.
12. In Kexi, Alt+DownArrow drops down pick lists in property dialogs.
13. Since the new shortcuts use the standard kdelibs KShortcut object, shortcuts may be customized by the
user in the Configure Shortcuts dialog.

Recommendations to Developers
The following are specific recommendations for additional changes to the KOffice and kdelibs software to address
some of the accessibility problems enumerated in this document:
1. Change applications so that panels can be directly reached using Alt and a number key. Alt+1 goes to
the first panel, Alt+2 the second, etc. Kexi and KWord already have such an implementation and this
should be added to the other KOffice applications as well.
2. Font Selector widget. Preparer is guessing that this widget does its own dropdown rendering in order to
support displaying the name of each of the fonts in that font. It should be enhanced to render in the font
size of the theme.
3. Fix bugs in certain dialogs causing frames to be cut off in the Big font themes. Incorrect SizePolicy?
4. Change IconView so that focus rectangle is separated from the selection background by a few pixels.
5. Fix widgets/applications that are somehow preventing Popup Context Menu global shortcut from
working.
6. KWord needs a set of frame/table templates that are designed for high contrast themes. These should
automatically be the default when using such themes, but user-overridable.
7. Either change QToolbarButton so that it can receive focus, or each application should provide more
default shortcuts. The multi-key shortcut feature can be used effectively for this by combining functions
that are on the same toolbar into a popup menu. Another solution is for widgets on toolbars to become
focusable when a function key (F10 suggested) is pressed. (Note: Does it really make sense for some of
the buttons on toolbars to be focusable while most are not?)
8. Menu items and shortcuts should be provided for navigating forward/backwards through pages of multipage documents in Kivio. Since KSpread already supports Ctrl+PgDn and Ctrl+PgUp, suggest the same
for Kivio.
9. Menu items and shortcuts should be provided for selecting chart types in KChart.

Disclaimer
This document is for informational purposes only. KDE e.V., Trolltech, and the preparer make no
warranties, express, implied, or statutory, in this document. The information in this document represents the
current view of the preparer on the issues discussed as of the date of publication. It should not be interpreted
to be a commitment on the part of KDE e.V., Trolltech, or the preparer.

